Lifecycle management console for SAP BusinessObjects Business Intelligence platform 4.0 User Guide

- SAP BusinessObjects 4.0 Support Package 02
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.8.1</td>
<td></td>
<td>Promoting a Job When the Repositories are Connected</td>
<td>33</td>
</tr>
<tr>
<td>5.8.2</td>
<td></td>
<td>Promoting a Job When the Repositories are not Connected</td>
<td>35</td>
</tr>
<tr>
<td>5.9</td>
<td></td>
<td>Scheduling a Job in Lifecycle management console</td>
<td>37</td>
</tr>
<tr>
<td>5.9.1</td>
<td></td>
<td>Scheduling a Job Promotion</td>
<td>39</td>
</tr>
<tr>
<td>5.9.2</td>
<td></td>
<td>Updating the Recurring and Pending Job Promotion Instances</td>
<td>40</td>
</tr>
<tr>
<td>5.10</td>
<td></td>
<td>Viewing the History of a Job</td>
<td>41</td>
</tr>
<tr>
<td>5.10.1</td>
<td></td>
<td>Rolling Back a Job</td>
<td>42</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Managing Different Versions of an Infoobject</td>
<td>45</td>
</tr>
<tr>
<td>6.1</td>
<td></td>
<td>Backing Up and Restoring Subversion Files</td>
<td>46</td>
</tr>
<tr>
<td>6.1.1</td>
<td></td>
<td>Backing Up Subversion Files</td>
<td>46</td>
</tr>
<tr>
<td>6.1.2</td>
<td></td>
<td>Restoring Subversion Files</td>
<td>47</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Using the Command Line Option</td>
<td>49</td>
</tr>
<tr>
<td>7.1</td>
<td></td>
<td>Running the Command Line Option in Windows</td>
<td>49</td>
</tr>
<tr>
<td>7.1.1</td>
<td></td>
<td>Running the Command Line Option in UNIX</td>
<td>50</td>
</tr>
<tr>
<td>7.2</td>
<td></td>
<td>Command Line Option Parameters</td>
<td>50</td>
</tr>
<tr>
<td>7.3</td>
<td></td>
<td>Sample Properties File</td>
<td>57</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Using the Enhanced Change and Transport System</td>
<td>59</td>
</tr>
<tr>
<td>8.1</td>
<td></td>
<td>Pre-requisites</td>
<td>59</td>
</tr>
<tr>
<td>8.2</td>
<td></td>
<td>Configuring the Integration</td>
<td>60</td>
</tr>
<tr>
<td>8.2.1</td>
<td></td>
<td>Setting Up CTS for BusinessObjects-Lifecycle Management Console Usage</td>
<td>60</td>
</tr>
<tr>
<td>8.3</td>
<td></td>
<td>Promoting a Job Using CTS</td>
<td>65</td>
</tr>
<tr>
<td>A</td>
<td></td>
<td>More Information</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td></td>
<td>71</td>
</tr>
</tbody>
</table>
Introduction

1.1 About this guide

Lifecycle management console for SAP BusinessObjects Business Intelligence platform 4.0 is a web-based tool that enables you to move business intelligence (BI) resources from one repository to another, manages dependencies of the resources and also rolls back the promoted resources at the destination system if required. It also supports the management of different versions of the same BI resource.

This guide introduces you to the lifecycle management console tool and discusses its features. It also describes how to use the different features that this tool supports.

This guide is intended for system administrators and users who work with business intelligence (BI) resources over the web by using the lifecycle management tool.

1.2 What is Lifecycle management console?

The lifecycle management console refers to the set of processes involved in managing information related to a product life cycle, from the stage of concept through delivery. It establishes procedures for governing the entire product life cycle, which includes phases such as development, testing, and production. These phases can occur at the same site or at different geographical locations.

The BI resources that are present in the development repository must be transferred to the testing repository for testing deployment. The time required to transfer resources from one repository to another repository must be minimal, to obtain a high-quality and competitive product. These resources also have dependencies that have to be moved from one repository to another. The dependencies of resources adds complexity to the movement of resources, because these resources have to move along with the dependents.

Lifecycle management console for SAP BusinessObjects Business Intelligence platform 4.0 is a web-based tool that enables you to move BI resources from one system to another system, without affecting the dependencies of these resources. It also enables you to manage different versions of BI resources, manage dependencies of BI resources, and roll back a promoted resource to restore the destination system to its previous state.
The lifecycle management console tool is a plug-in for the SAP BusinessObjects Business Intelligence platform application. You can promote a BI resource from one system to another system only if the same version of the SAP BusinessObjects Business Intelligence platform application is installed on both the source and destination systems.
Lifecycle management console Features

The lifecycle management console supports the following features:

- **Promotion** - This feature enables you to create or update infoobjects in the destination system. Apart from promoting infoobjects, it enables you to perform the following tasks:
  - Create a new job
  - Copy an existing job
  - Edit a job
  - Schedule a job promotion
  - View the history of a job
- **Managing Dependencies** - This feature enables you to select, filter, and manage dependents of infoobjects in the job that you want to promote.
- **Scheduling** - This feature enables you to specify a time for job promotion, rather than promote a job as soon as it is created. You can specify the time for job promotion by using any of the following parameters: hourly, daily, weekly, or monthly.
- **Security** - This feature enables you to promote infoobjects along with the associated security rights. You can also use this feature to promote infoobjects associated with application rights.
- **Test Promotion** - This feature enables you to check or test the promotion to ensure that all the preventive measures are taken before the actual promotion of the infoobjects.
- **Rollback** - This feature enables you to restore the destination system to its previous state, after a job is promoted. You can roll back an entire job or a part of the job.
- **Auditing** - The events generated by the lifecycle management console are stored in the audit database. The Auditing feature enables you to monitor the events that are logged in the audit database.
- **Administration options** - This feature enables the administrator to configure the parameters of the lifecycle management console.
- **Version Management** - This feature enables you to manage different versions of the same document. It also enables you to track the changes in the directory.
- **Promoting Overrides** - This feature enables you to promote the overrides through a job promotion.

### 2.1 Authorization

The lifecycle management console tool allows you to log into the source system only if you have adequate permissions. However, to promote a job, the user must have adequate permissions on both the source and the destination systems.
The lifecycle management console tool allows you to log into different CMSs while creating, editing, or promoting a job. You can select the appropriate CMS from the CMS drop-down list, provided you have adequate rights. The administrator creates the list of CMSs that the lifecycle management tool users can log into. You can also add new CMSs to the list.

Whenever you log into a CMS, the lifecycle management console tool stores your login credentials in the job session. Hence, you need not log into the same CMS multiple times within a single session.

The following table lists the permission types required to perform various operations with the lifecycle management console tool:

<table>
<thead>
<tr>
<th>User Rights on the Lifecycle management console</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Job</td>
<td>To create a job</td>
</tr>
<tr>
<td>Edit Job</td>
<td>To edit jobs and folders, and add infoobjects, user groups, and folders</td>
</tr>
<tr>
<td>Promote Job</td>
<td>To promote or test promote a job</td>
</tr>
<tr>
<td>Delete Job</td>
<td>To delete a job</td>
</tr>
<tr>
<td>Export as LCMBIAR file</td>
<td>To export as an LCMBIAR file</td>
</tr>
<tr>
<td>Edit an LCMBIAR file</td>
<td>To edit an LCMBIAR file</td>
</tr>
<tr>
<td>Rollback Job</td>
<td>To rollback a job</td>
</tr>
<tr>
<td>Use Administration options</td>
<td>To set or configure various options for the lifecycle management console tool</td>
</tr>
<tr>
<td>Edit Connections properties</td>
<td>To edit the properties of a connection</td>
</tr>
<tr>
<td>Use Version Management System</td>
<td>To set the version control system</td>
</tr>
</tbody>
</table>

2.2 Security

The lifecycle management console tool supports the following security options:

- Do not Promote Security - If you select this option, jobs are promoted without the associated security rights. This is the default option.
- Promote Security - If you select this option, jobs are promoted along with the associated security rights.
- Include application rights - If the infoobjects in the job inherit any application rights, the job is promoted along with these application rights. This option is enabled only if you select Promote Security.

The following table discusses the behavior of infoobjects in relation to the supported security options:
2.3 Application Access Rights

This section describes the application access rights for lifecycle management console.

- You can set access rights to the lifecycle management console application within the CMC.
- You can set granular application rights to various functions within lifecycle management console.

To set specific rights in the lifecycle management console application, complete the following steps:

1. Log into CMC and select Applications.
3. Click User Security, and select Administrators.
   
   The View Security tab is enabled.
4. Select the rights you want to set.
   
   You can set the following rights:
   - Create a job
- Edit a job
- Promote a job
- Export a BIAR file
- Edit a BIAR file
- Delete a job
- Rollback a job
- Use Administration options
- Edit Connections properties
- Use Version Management System

5. Click **OK**.

The lifecycle management console application access rights are set within the CMC.
User Interface components of Lifecycle management console

This chapter discusses the GUI components in the lifecycle management console tool. The lifecycle management console tool home page is divided into the following panels:
- lifecycle management console workspace toolbar
- Workspace panel
- Tree panel
- Administrator and Details panel
- Shopping Cart and Job Viewer page

Lifecycle management console workspace toolbar
The lifecycle management console workspace toolbar displays the options that you can use to perform operations such as creating and deleting a folder, creating a new job, editing, promoting, rolling back a job, importing a BIAR file and checking properties.

Workspace panel
The Workspace panel in the lifecycle management console home page displays the list of newly created jobs. You can use this panel to view the name of the job, status of the job, job creation information, promotion summary, test promotion summary, dependency management screens, and information about the destination system.

Tree panel
The Tree panel in the lifecycle management console home page displays the tree structure, which includes the Promotion Jobs folder and the Promotion Status folder. The newly created jobs are displayed in a hierarchical structure under the Promotion Jobs folder. The promoted jobs are listed according to their status of promotion in the Promotion Status folder.

Administrator and Details panel
The Administrator and Details panel includes the Administration Options link. The system administrator can use this link to access the Administration options. It also includes the Preferences link that enables the administrator and users to set the lifecycle management console preferences. The Help and About links enable you to obtain more information about using the lifecycle management console tool.

Shopping Cart and Job Viewer page
A Shopping Cart is a dynamically generated hierarchical tree list that contains a list of the infoobjects to be promoted. It displays the root folder and the objects folder for both selected and dependent objects. The Job Viewer page enables you to view the infoobjects that are added to a job.
Getting Started

This section describes how to get started and set various options with the lifecycle management console tool.

4.1 Logging into Lifecycle management console

This section describes how to log into the lifecycle management console tool.

To log into the lifecycle management console tool, complete the following steps:

1. Select Start > Programs > SAP BusinessObjects 4.0 > SAP BusinessObjects Business Intelligence platform > Lifecycle management console.

   The lifecycle management console login screen appears.

2. In the System field, enter the name of the Central Management Server (CMS) on which the lifecycle management console tool is installed.

3. Enter the User Name and Password.

4. Select the appropriate authentication method from the Authentication drop-down list.

   The lifecycle management console tool supports the following authentication types:

   • Enterprise - Use the system default Enterprise Authentication if you prefer to create distinct accounts and groups for use with SAP BusinessObjects Business Intelligence platform.

   • LDAP - If you set up an LDAP directory server, you can use existing LDAP user accounts and groups in SAP BusinessObjects Business Intelligence platform.

   • Windows AD - You can use existing Windows AD user accounts and groups in SAP BusinessObjects Business Intelligence platform.

   • SAP - You can map existing SAP roles into SAP BusinessObjects Business Intelligence platform accounts. After you map SAP roles, you can log on to SAP BusinessObjects Business Intelligence platform applications with the SAP credentials.

   The LDAP, Windows AD, and other third-party authentication types require a special setup. For information on setting up these authentication types, see the SAP BusinessObjects Business Intelligence platform Administrator Guide.

5. Click Log on.

   The "Promotion Jobs" home page appears.
Note:
Any user with View permissions to the lifecycle management folder can log into the lifecycle management console tool. However, to create, schedule, or promote a job, the user must be granted additional rights by the administrator.

4.2 Using the Administration Options

The Administration options enable you to configure settings before promoting infoobjects from one SAP BusinessObjects Enterprise deployment to another SAP BusinessObjects Enterprise deployment and SAP deployment. This section describes how to use the administration options.

To access the Administration options, click the Administration Options link in the "Promotion Jobs" screen. The "Administration Options" dialog box appears. This dialog box displays the following options:

- Manage Systems - This option enables you to add and remove the host systems.
- Override Settings - This option enables you to override the properties of infoobjects such as data connection, CR connection, and Qaaws, within the job that were promoted to the destination system. It overrides the properties of infoobjects that were promoted from the source system.
- Rollback Settings - This option enables you to configure the rollback process at the system level.
- Job Settings - This option enables you to specify the number of job instances that can exist in lifecycle management console system at any instance of time. If the number of jobs exceed the specified number, they are automatically deleted. It also enables the user to specify the number of days for a job, after which the job must be deleted from the lifecycle management console.
- VMS Settings - This option enables you to configure version management systems.

4.2.1 Using the Manage Systems Option

This section describes how to use the Manage Systems option. You can add or remove host systems by using this option.

To add a host system, complete the following steps:

1. In the "Administration Options" window, click Manage Systems.
   The "Manage Systems" window appears. This window displays a list of host names, port numbers, display names, and description.
2. Click Add.
   The "Add System" dialog box appears.
3. Add the host name, port number, display name, and the description in the appropriate fields.

Note:
Select the Mark as 'Origin' option to identify the system as a source system.
4. Click **OK** to add the system.
   The host system is added to the list.

**Note:**
To remove a host system, select the host system you want to remove, and click **Remove**.
You can also edit the host name, port number, display name, and the description.

### 4.2.2 Using the Override Settings Option

The Override Settings option enables you to promote the overrides through a job promotion or through the BIAR files.

#### 4.2.2.1 Promoting Overrides

Add a host system before promoting the overrides. For information about adding host systems, see 4.2.2.1 Promoting Overrides.

To promote the overrides, complete the following steps:

1. In the "Administration Options" window, click the **Override Settings** option.
   The "Override Settings" window appears.
2. Click **Login**.
   The "Login to system" window appears.
3. Select the source system marked as **Origin** to scan the objects, and login to the system using valid credentials.
4. From the **Start** drop-down list next to **Scan**, select the **Start** option.
The scanning process starts. The "List of Overrides" is displayed.

**Note:**
To schedule the scan to suit your preferences, select **Recurrence Settings** option from the drop-down list.

5. In the list of overrides, change the status to Active for the objects you want to promote, and click **Save**.

6. Click **Promote Overrides**.
   The "Promote Overrides" screen appears where the list of destination systems is displayed.

7. Click **Login** to log into the destination system using valid credentials.
   You can specify multiple destination systems.

8. Click **Promote**.

9. From the "Override Settings" screen, click **Login**.
   The Login to System window appears.

10. Login to the destination system using valid credentials.
    A list of all the promoted objects is displayed in "list of overrides". The status of these objects is Inactive.

11. Click the **Select** check box for the objects you want to edit, and click **Edit**.

12. Update the required values, and click **Done**.

13. Change the state of the objects to Active and click **Save**.

**4.2.2.2 Promoting Overrides Through BIAR Files**
Add a host system before promoting the overrides. For information about adding host systems, see Using the Manage Systems Option.

To promote the overrides through BIAR files, complete the following steps:

1. In the "Administration Options" window, click the Override Settings option. The "Override Settings" window appears.

2. Click Login. The "Login to system" window appears.

3. In the "Override Settings" screen, select the source system marked as Origin to scan the objects and login to the system using valid credentials.

4. From the Start drop-down list next to Scan, select the Start option. The scanning process starts. The List of Overrides is displayed.

5. In the list of overrides, change the status of the required objects to Active, and click Save.

6. Click Promote Overrides. The "Promote Overrides" screen appears where the list of destination systems is displayed.

7. To encrypt the BIAR file using a password, click Password Encryption checkbox. The Password and Confirm Password fields are enabled.

8. Enter a password in the Password field. Re-enter the same password in the Confirm Password field.

9. Click Export, and save the overrides BIAR file to a file system.

10. Log into the destination system through the LCM tool, and click Import > Override File. The "Import LCMBIAR file" window appears.
11. Click **Browse** to browse the BIAR file.
12. Enter the password of the BIAR file in the **Password** field.

   **Note:**
   The **Password** field appears only if the BIAR file you selected is encrypted using a password.

13. Click **OK**.
14. From the "Override Settings" screen, click **Login**.
    The "Login to system" window appears.
15. Login to the destination system using valid credentials.
    A list of imported objects is displayed in List of Overrides. The status of these objects is Inactive.
16. Click the **Select** check box for the objects you want to edit, and click **Edit**.
17. Update the required values, and click **Done**.
18. Change the status of the objects to “Active” and click **Save**.

### 4.2.2.3 Promoting Overrides Through CTS+

Add a host system before promoting the overrides. For information about adding host systems, see [Using the Manage Systems Option](#).

To promote the overrides through CTS+, complete the following steps:

**Note:**
Login to the Lifecycle Management Console tool using SAP authentication for this option to be available.

1. In the "Administration Options" window, click the **Override Settings** option.
   The "Override Settings" window appears.
2. Click **Login**.
   The "Login to system" window appears.
3. Select the source system marked as **Origin** to scan the objects, and login to the system using valid credentials.
4. From the **Start** drop-down list next to **Scan**, select the **Start** option.
   The scanning process starts. The "List of Overrides" is displayed.

   **Note:**
   To schedule the scan to suit your preferences, select **Recurrence Settings** option from the drop-down list.
5. In the list of overrides, change the status to Active for the objects you want to promote, and click **Save**.
6. Click **Promote Overrides**.
   The "Promote Overrides" screen appears where the list of destination systems is displayed.
7. From the **Promotion Options** drop-down list, select **Promote with CTS+**.
8. Click **Promote**.
9. Release the overrides to the destination system by completing the following steps:
   a. Login to the domain controller of CTS+ and open the "Transport Organizer" Web UI. For more information on using the Transport Organizer Web UI, see [http://help.sap.com/saphelp_nw70ehp1/helpdata/en/b5/6d03660d3745938cd46d6f5f9cef2e/frame set.htm](http://help.sap.com/saphelp_nw70ehp1/helpdata/en/b5/6d03660d3745938cd46d6f5f9cef2e/frame set.htm)
   b. If the status of the request is **Modifiable**, click **Release** to release the transport request of the overrides. For more information on Releasing Transport Requests with Non-ABAP Objects, see [http://help.sap.com/saphelp_nw70ehp1/helpdata/en/55/07c497db8140ef8176715d4728eec1/frame set.htm](http://help.sap.com/saphelp_nw70ehp1/helpdata/en/55/07c497db8140ef8176715d4728eec1/frame set.htm)
   c. Close the "Transport Organizer" Web UI.
10. Import the overrides to the destination system by completing the following steps:
    a. Login to the Domain Controller of CTS+.
    b. Call the STMS transaction to enter the transport management system.
    c. Click on the **Import Overview** icon.
        The "Import Overview" screen appears and you can view the import queue items from all the systems.
    d. Click the System ID of the destination LCM system.
        You can see the list of transport requests that can be imported to the system.
    e. Click **Refresh**.
    f. Import the relevant transport requests. For more information, see [http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a39e7acc11d1899e0000e829fbbd/frame set.htm](http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a39e7acc11d1899e0000e829fbbd/frame set.htm)
11. Login to the destination system using valid credentials.
    A list of all the promoted objects is displayed in "list of overrides". The status of these objects is Inactive.
12. Click the **Select** check box for the objects you want to edit, and click **Edit**.
13. Update the required values, and click **Done**.
14. Change the state of the objects to Active and click **Save**.

### 4.2.3 Using the Rollback Settings Option

The Rollback Settings option allows you to disable the rollback process at the system level. By default, the rollback process is enabled at the system level.

To disable the rollback process at the system level, complete the following steps:
1. In the "Rollback" window, from the list of host systems, select the host system to disable the rollback process.
2. Click **Save and Close** to save the modifications.

### 4.2.4 Using the Job Settings Option

The Job Settings option enables you to specify the number of job instances that can exist in the system. You can specify one of the following options:

- **Delete Instances when there are more than N instances of a Job** - This option enables you to specify the maximum number of job instances per job that can exist in the system.
- **Delete Job Instances after N days** - This option enables you to specify that all job instances created before the specified number of days must be deleted.

To set the **Job Settings** option, complete the following steps:

1. Select the option, and enter the preferred value.
2. Click **Save** to save the updated changes.

You can click **Default Settings** to set the default values, and you can click **Close** to close the window.

**Note:**
The old job instances are deleted only when the job is executed the next time.

### 4.2.5 Using the Version Management System Settings Option

The lifecycle management console tool enables you to set the version management system settings. You can select either SubVersion or ClearCase version management system.

To set the SubVersion management system, complete the following steps:

1. In the "Administration Options" window, click **VMS Settings**.
2. From the **Version Management Systems** drop-down list, select **SubVersion**.

   By default, the server port, password, repository name, server name, user name, workspace directory, and the install path, which are provided during the lifecycle management console installation, are displayed in the appropriate fields.
3. Modify the fields, if required.

   Ensure that you enter the Install Path extending till the `.exe` file. In Windows, For example:
   
   - C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Business Intelligence platform 4.0\subversion
   - In Unix /usr/u/qaunix/aurosra_730/sap_bobj/enterprise_40/subversion/bin

4. Click **Save**.

   **Note:**
   
   - If you want SubVersion as your default VMS, then select **Use as Default VMS**.
   - If you have modified the fields as per Step 3, restart the Server Intelligence Agent.

### 4.2.5.1 Setting the ClearCase Version Management System in Windows

To set the ClearCase version management system in Windows, complete the following steps:

1. In the "Administration Options" window, click **VMS Settings**.
2. From the **Version Management Systems** drop-down list, select **ClearCase**.
3. Enter the following details:
   - **ClearCase Map Drive** - Enter the drive name. By default, it is the M drive. For example: M:
   - **VOB Tag Name** - Enter the Versioned Object Base (VOB) name. For example: FridayVB
   - **View Storage Directory** - Enter the path to the shared folder. For example: `\HostName\FolderName`

   **Note:**
   The host name must not be written as localhost.

4. Click **Save**.

### 4.2.5.2 Setting the ClearCase Version Management System in Unix

To set the ClearCase version management system in Unix, complete the following steps:

1. In the Administration Options window, click **VMS Settings**.
2. From the Version Management Systems drop-down list, select **ClearCase**.
3. Enter the following details:
   - **ClearCase Map Drive** - Enter the name of the folder where the MVFS is located. By default, it is `/view`
   - **VOB Tag Name** - Enter the VOB name and the folder where the VOB is located. For example: `VobFolder/VobName`
   - **View Storage Directory** - Enter the path of the directory where the views are created.

   **Note:**
   You can select **Use as Default VMS** if you want to use ClearCase as the default version management system.
4.3 Setting Preferences

You can specify the number of jobs that must be displayed in the "Promotion Jobs" screen. You can also view jobs that were created during a particular time interval.

To set the lifecycle management console preferences, complete the following steps:
1. In the "Promotion Jobs" screen, click the Preferences link.
   
   The "Preferences" window appears.
2. In the Enter the maximum Page size field, specify the number of objects that must be displayed per page in the "Promotion Jobs" screen.
3. From the Show Jobs Created drop-down list, select the time interval to view the jobs created during the specified period.

   Note:
   You can specify the product locale, current time zone, and preferred viewing locale in the "Preferences" page.

4. Click OK.

   Note:
   The values set in "Preferences" page are specific to each session.

4.4 Logging Options

The logging options in lifecycle management console tool enable you to obtain logging details of the application.

You must update the following trace log settings before viewing the log files:
- UI/Web Tier Logs: Change the trace log level to high in CMC application.
  
  To set the trace log level high in CMC:
  1. Launch CMCapp > Application > Central Management Console.
  2. Right-click, and select Trace log settings.
  3. Select log level as High.

- VMS Service/ LCM Scan and Service logs: Change the trace log level to high in AdaptiveProcessingServer.
  
  To set the trace log level high in AdaptiveProcessingServer:
  1. Launch CMCapp > Servers > AdaptiveProcessingServer.
  2. Right-click, and select Properties > Trace log service.
3. Select log level as **High**.

- Scheduling Services: Change the trace log level to high in AdaptiveJobServer.
  
  To set the trace log level high in AdaptiveJobServer:
  
  1. Launch **CMCAp** > **Servers** > **AdaptiveJobServer**.
  2. Right-click, and select **Properties** > **Trace log service**.
  3. Select log level as **High**.

**Note:**
By default, the lifecycle management console logging level is set to INFO. Only System Administrator can set the environment variables in the operating system. The procedure for setting environment variables differs from one operating system to another.
Using Lifecycle management console

Promotion Job

When you log into the lifecycle management console application, by default, you are taken to the "Promotion Jobs" page. The "Promotion Jobs" home page screen includes various tabs that you can use to perform the following tasks:

- Select **New Job** to select job-related processes. You can also right-click the home page screen and select the job-related processes from the list.
- Select **Import > Import LCMBIAR file** to import a BIAR file directly from the file system, instead of performing the entire procedure of creating a new job.
- Select **Edit** to edit the existing jobs.
- Select **Promote** to promote a job from the source system to the destination system, or export a job to a BIAR file.
- Select **Rollback** to revert the promoted jobs from the destination system.
- Select **History** to view the previous promotion instances of the job.
- Select **Properties** to view the properties of the selected job instance, such as title, ID, file name, and description.

The "Promotion Jobs" application area displays the jobs that exist in the system, along with the following information for each job:

- **Name**: Displays the name of the job that was created.
- **Status**: Displays the status of the job, such as Created, Success, Partial Success, Running, or Failure.
- **Created**: Displays the date and time when the job was created.
- **Last Run**: Displays the date and time when the job was last promoted.
- **Source System**: Displays the name of the system from which the job is promoted.
- **Destination System**: Displays the name of the system to which the job is promoted.
- **Created by**: Displays the name of the user who created the job.

5.1 Creating a New Job

This section describes how to create a new job by using the lifecycle management console tool.

The following table discusses the GUI elements and fields that you can use to create a new job:
To create a new job, complete the following steps:

1. Log into the lifecycle management console tool.
2. In the "Promotion Jobs" home page, select **New Job**. The "New Job" window appears.
3. Enter the name, description, and keywords for the job in the appropriate fields.
4. In the **Save Job in** field, browse and select the folder in which you want to save the job.
5. From the **Source** and the **Destination** drop-down lists, select the source system and the destination system respectively.

   If the name of the source and destination systems is not displayed in the drop-down list, select the **Login to a new CMS** option. A new window is launched. Enter the name of the system along with the user name and password.

6. Click **Create**.

   A new job is created and stored in the CMS repository of the source system.

**Note:**
Providing information in the **Description**, **Keywords**, and **Destination** fields is optional.

### 5.2 Creating a New Job by Copying an Existing Job
You can create a new job by copying an existing job.

To create a new job by copying an existing job, complete the following steps:
1. Log into the lifecycle management console tool.
2. In the "Promotion Jobs" home page, click New Job.
3. Click the Copy an Existing Job option.
   The list of jobs in the Promotion Jobs folder is displayed.

4. Select the required job from the job list, and click Create.
   The name, keywords, and description of the job are displayed. You can modify these fields, if required. However, you cannot change the source system.

5. In the Save Job in field, browse and select the folder in which you want to save the job, and click Create.
   A new job is created.

### 5.3 Searching for a Job

The search feature in the lifecycle management console tool enables you to locate a job that is available in the lifecycle management console repository.

To search for a job, complete the following steps:
1. In the Search field of the lifecycle management console home page, enter the text that you want to locate.
2. Select the list that appears beside the Search field to specify the search parameters. The lifecycle management console tool supports the following search parameters:
   - Search Title
   - Search Keyword
   - Search Description
   - Search All Fields
3. Click the Search icon.
5.4 Editing a Job

This section describes how to edit a job.

**Note:**
Editing a job does not amount to creating a new job.

To edit a job, complete the following steps:
1. Log into the lifecycle management console tool.
2. In the "Promotion Jobs" home page, select the job that you want to edit, and click **Edit**.

   The details of the selected job are displayed. Based on your requirements, you can add or remove infoobjects.

**Note:**
While editing a job, you cannot change the source system to another CMS.

5.5 Adding an Infoobject to a Job

Each job must include a set of infoobjects and their dependents. Hence, you must add infoobjects to a job before you promote it to the destination system.

To add an infoobject to a job, complete the following steps:
1. Log into the lifecycle management console tool.
2. Create a new job. For information on creating a new job, see **Creating a New Job**
3. Click **Add Objects**.
   The "Add Objects" screen appears. The folder and subfolders are displayed in a tree structure.
4. Navigate to the folder from which you want to select the infoobject.
   The list of infoobjects in the selected folder is displayed.
5. Select the infoobject that you want to add to the job, and click **Add**.
   If you want to add an infoobject and exit the "Add Objects" screen, click **Add and Close**. The infoobject is appended to the job, and the "Add Objects" screen closes.

After you add an infoobject to a job, you can right-click the "Job Viewer" page and select the job-related processes to proceed with the promotion task. You can also use the **Manage Dependencies** option in the "Job Viewer" page, to manage the dependents of the infoobject you selected.
Note:

- The Shopping Cart, which appears in the left panel of the "Job Viewer" page, displays the name of the job, and the name of the folders. When you select an object, the folders to which the selected object belongs are implicitly displayed in a hierarchical tree structure.
- Click Save after adding infoobjects. Otherwise, the user is prompted with an option to save the job when the user closes the tab.

Best Practice: SAP Business Objects recommends that you select a small number of infoobjects, which should not exceed 100 at a time, for promotion to obtain optimum performance of the lifecycle management console tool.

Related Topics
- Creating a New Job
- Editing a Job

5.6 Searching for Dependents

The advanced search feature in lifecycle management console enables you to locate the dependents of infoobjects that are available in the repository.

To search for the dependents of an infoobject, complete the following steps:
1. Log into the lifecycle management console tool.
2. Create a new job, or edit an existing job.
   - If you have created a new job, add infoobjects to the job. If you are editing an existing job, you can add infoobjects, if required.
3. Click Manage Dependencies.
4. In the Search Dependents field, enter the name of the dependent you want to locate.
5. Click the Search icon.

Related Topics
- Managing Job Dependencies

5.7 Managing Job Dependencies

In an SAP BusinessObjects Business Intelligence platform environment, infoobjects are dependent on other infoobjects. For example, a Web Analysis document is dependent on the underlying Universe for its structure, content, and so on. While promoting an object, you can select and filter the dependents.
that you want to promote, or permit the promotion of all the dependents to another SAP BusinessObjects Business Intelligence platform system. To select and filter the dependents you want to promote along with the infoobject, you must use the Manage Dependencies option. If you do not use this option, the dependents are not promoted along with the job.

The following table discusses options that you can use to manage the dependents:

<table>
<thead>
<tr>
<th>Types of Dependency objects</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universe for selected reports</td>
<td>Promotes the universe on which the selected infoobject is dependent.</td>
</tr>
<tr>
<td>Selected universes, Universe restriction set</td>
<td>Promotes universes that are dependent on other universes and Universe restriction set.</td>
</tr>
<tr>
<td>Access levels set on selected objects</td>
<td>Promotes access levels that are used on the selected infoobjects.</td>
</tr>
<tr>
<td>Connections used by selected universes</td>
<td>Promotes universe connection objects that are used by the selected infoobjects.</td>
</tr>
<tr>
<td>Business Views for selected reports</td>
<td>Promotes Business Views, Business elements, Data foundation, data connection, and List of Values (LoVs) that the selected infoobjects depend on.</td>
</tr>
<tr>
<td>Events, calendars, profiles used by selected publication</td>
<td>Promotes event, calendar, and user profile objects that are used by a selected publication.</td>
</tr>
</tbody>
</table>

To manage dependencies of an infoobject, complete the following steps:
1. Log into the lifecycle management console tool.
2. Create a new job. For information on creating a new job, see Creating a New Job.
3. Add the required infoobjects to the new job.
4. In the "Promotion Jobs" home page, click Manage Dependencies.
The "Manage Dependencies" window appears. This window displays the list of infoobjects and their dependents, as shown in the following figure:

5. From the Select Dependents drop-down list, select any of the options available to add the dependents to the job. The dependents are displayed on the right side. The dependents are not selected by default; you must explicitly select the dependents you want to promote.

For example, if you select All Universes from the Select Dependents drop-down list, then all the universes included in the list of dependents are automatically selected.

**Note:**
You can also select the dependents manually.

When you select the dependents from the Dependents column, the dependents are automatically moved to the Objects in Job column.

You can also enter the name of the dependent in the Search Dependents field to search for a dependent. For more information on searching for the dependents, see Searching for Dependents.

6. Click 📚 to view the supported filtering options of infoobjects in the drop-down list. Select an option, and click OK. The filtered infoobjects are displayed.

7. Click Apply Changes to update the list of dependents.

8. Click Apply & Close to update the list and save the changes.

**Note:**
- Dependent objects are computed automatically by the lifecycle management console tool. These dependents are computed based either on the infoobject relationships or infoobject properties.
- If you select a folder for promotion, then the contents in the selected folder are considered as primary resources.
- In the "Manage Dependencies" screen, when you place the cursor on the scheduled infoobject, a tool tip appears describing the file name, file path, created date and time, last modified date and time, next run, expiry, owner, and recurrence of the schedule.
5.8 Promoting a Job

This section describes the workflows that the lifecycle management console tool supports for promoting a job from the source system to the destination system.

• When the repositories (source system and the destination system) are connected
• When the repositories (source system and the destination system) are not connected

5.8.1 Promoting a Job When the Repositories are Connected

This section describes how to promote a job from a source system to a destination system if the repositories are connected.

The following table lists the infoobject types that can be promoted by using the lifecycle management console tool:

<table>
<thead>
<tr>
<th>Category</th>
<th>Object types you can promote</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Crystal reports, Web Analysis, Xcelsius, QaaWS, Explorer</td>
</tr>
<tr>
<td>Third-Party Objects</td>
<td>Rich text, Text document, Microsoft Excel, Microsoft PowerPoint, Microsoft Word, Flash, Adobe acrobat</td>
</tr>
<tr>
<td>Users</td>
<td>Users and user groups</td>
</tr>
<tr>
<td>Server</td>
<td>Server groups</td>
</tr>
<tr>
<td>Business Intelligence Platform</td>
<td>Folder, Program, Events, Profiles, Object package, HyperLink, Categories, Alerts</td>
</tr>
<tr>
<td>Universe, Workspace</td>
<td>Universes UNV, Connections</td>
</tr>
<tr>
<td>EPM Dashboard</td>
<td>Universes, Connections, Reports, Dashboard, and Analytics</td>
</tr>
<tr>
<td>BusinessView</td>
<td>DataFoundation</td>
</tr>
<tr>
<td>Federation</td>
<td>Federation</td>
</tr>
<tr>
<td>• Replication List</td>
<td></td>
</tr>
<tr>
<td>• Replication Jobs</td>
<td></td>
</tr>
</tbody>
</table>
To promote a job, complete the following steps:

1. **Log into the lifecycle management console tool.**
   - The "Promotion Jobs" home page appears.

2. **Perform any of the following operations:**
   - Right-click the job that you want to promote, and select **Promote**.
   - Select the job that you want to promote, and click the **Promote** tab.
   - The "Promote" window appears.

3. **From the Source and the Destination drop-down lists, select the source and destination systems respectively.**
   - **Note:** Ensure that you have logged into both the source and destination systems before you proceed with the promotion process.

4. **In the Change Management ID field, enter the appropriate value, and click **Save**.**
   - **Note:** The Change Management ID is used for obtaining information related to logging, auditing, job history, and so on. The lifecycle management console tool enables you to map each instance of job creation to a change in the Management ID. The Management ID is an attribute that is set by the user in the job definition while creating a new job. The lifecycle management console tool automatically generates an ID for each job.

5. **Click **Security Settings**, if required.**
   - The following options are displayed:
     - Do not Promote Security - This is the default option.
     - Promote Security - Use this option to promote jobs along with the associated security rights.
     - Include application rights - This option is enabled only if you select **Promote Security**. If the objects in the job inherit any application rights, the job is promoted along with these rights.
   - You can also click **View Security** to view the security dependencies of the infoobjects in the job.

6. **Click **Test Promote** to ensure that there is no conflict between CUIDs in the source and destination systems.**
   - The promotion details are displayed. The first column displays the objects to be promoted, and the second column displays the promotion status. The lifecycle management console tool classifies the selected objects into users, groups, universes, and so on.
   - **Note:** Running the Test Promote feature does not commit any infoobjects for promotion.

   - The result of a test promote can be any of the following:
     - Overwritten - The infoobject in the destination is overwritten by the infoobject in the source system.
• Copied - The infoobject in the source system is copied to the destination system.
• Dropped - The infoobject is not promoted from the source system to the destination system.
• Warning - The infoobject in the destination system is the newer version and you can remove the infoobject from the Job. However, if you want to promote, the infoobject gets promoted.

7. Click **Schedule Job** if you want to schedule the job promotion.
8. Click **Promote**.

The selected job is promoted.

**Note:**
If you do not want to promote the job, you can use the **Save** option to save modifications such as Security, Change Management ID, and Schedule settings.

**Related Topics**
• Scheduling a Job Promotion
• Security

### 5.8.2 Promoting a Job When the Repositories are not Connected

Promoting refers to the activity of transferring a BI resource from one repository to another. If the source and destination systems are connected, the lifecycle management console tool uses WAN or LAN to promote the infoobject. However, lifecycle management console also facilitates the promotion of infoobjects even if the source and destination systems are not connected. In scenarios where the source and destination systems are not connected, the lifecycle management console tool enables you to promote jobs to the destination system by exporting a job from the source system to a BIAR file and then importing the same job from the BIAR file to the destination system.

This section describes how to export a job to a BIAR file and then import the job from the BIAR file to the destination system.

**Note:**
In the lifecycle management console tool, you cannot use a BIAR file that was created by using the Import Wizard tool.

#### 5.8.2.1 Exporting a Job to a BIAR File

This section describes how to export a job to a BIAR file.

To export a job to a BIAR file, complete the following steps:
1. Log into the lifecycle management console tool, and create a new job.
For more information on creating a new job, see Creating a New Job

2. From the Destination drop-down list, select Output to LCMBIAR file option and click Create.

3. Click Add Objects to add infoobjects to the job.
   You can use the Manage Dependencies option to manage the dependencies of the selected job.

4. Click Promote.
   The "Promote" window appears.

5. Modify these options per your requirements, and click Export.
   The BIAR file is created. You can save a BIAR file to a File System or an FTP location.

6. From the Destination drop-down list, select Output to LCMBIAR file, and click LCMBIAR File Destination.
   The LCMBiar File Destination pane appears.

7. Perform one of the following steps:
   • Select File System.
   • Select FTP, enter appropriate details in the host, port, username, password, directory, and filename fields.

8. To encrypt the LCMBIAR file using password, click Password Encryption checkbox.

9. Enter a password in the Password field.

10. Re-enter the password in the Verify Password field.

11. Click Export.
    The BIAR file is exported to the file system or an FTP location, depending on the option you select in step 7.

Related Topics
• Adding an Infoobject to a Job
• Managing Job Dependencies

5.8.2.2 Importing a Job from a BIAR File

Copy the BIAR file from the storage device to the destination system.
To import a BIAR file, complete the following steps:

1. Log into the lifecycle management console tool.
2. In the "Promotion Jobs" home page, click Import LCMBIAR.
   The "Import LCMBIAR file" window appears.
3. Click Browse and select a BIAR file from the file system.
4. In the Password field, Enter the password of the LCMBIAR file
   
   **Note:**
   The Password field appears only if the LCMBIAR file is encrypted with a password.
5. Click Create.
   The job is created.
6. Click Browse to select a folder to save the job, and click Create.
   You can also manage the dependencies of the job in the "Managing Dependencies" window.
7. Click Promote.
   The "Promote - Job Name" window appears.
8. From the Destination drop-down list, select the destination system. If you select Login to a New CMS, you will be prompted for credentials. Confirm the login credentials of the destination system.
9. Click Promote to promote the contents to the destination system.
   You can also click the Test Promote option to view the objects to be promoted and the promotion status.

5.9 Scheduling a Job in Lifecycle management console

The lifecycle management console tool enables you to specify when a job must be promoted, rather than promote it as soon as it is created. It also enables you to schedule job promotion at fixed intervals.

This feature is useful for promoting large jobs when the load on the server is at its minimum.

To schedule a job promotion, you must specify a time in future or select a recurrence pattern, and specify additional parameters.

The following table discusses the recurrence patterns that the lifecycle management console tool supports for scheduling a job promotion:

<table>
<thead>
<tr>
<th>Recurrence pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>If you select this option, the job is run as soon as you click Schedule.</td>
</tr>
<tr>
<td>Once</td>
<td>If you select this option, then the job is run only once. It can be run immediately, at a specified time in future, or when a specific event occurs.</td>
</tr>
</tbody>
</table>
### Recurrence pattern

<table>
<thead>
<tr>
<th>Recurrence pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>If you select this option, then the job is run every hour. You can specify the start time, as well as the start and end dates.</td>
</tr>
<tr>
<td>Daily</td>
<td>If you select this option, then the job is run every day. It can be run either once or several times a day. You can specify the hour when it must be run, and also the start and end dates.</td>
</tr>
<tr>
<td>Weekly</td>
<td>If you select this option, then the job is run every week. It can be run either once a week or several times a week. You can specify the day and time at which the job must be run, and also the start and end dates.</td>
</tr>
<tr>
<td>Monthly</td>
<td>If you select this option, then the job is run once every month or several times a month. You can specify the day and time of the month when the job must be run, and also the start and end dates.</td>
</tr>
</tbody>
</table>

### Run options

The following table discusses the parameters you can specify while scheduling a job promotion:

<table>
<thead>
<tr>
<th>Run option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X and N variables</td>
<td>The X and N variables are applicable for both Daily and Monthly recurrence patterns. When you select the Run option that contains these variables, the system displays their default values. However, you can modify these values per your requirements. For example, if you select the Daily recurrence pattern, and the Every N hour(s) and X minute(s) Run options, then you can schedule the report to run every 4 (X) hours and 30 (N) minutes. If you do not modify the X or N value, the system runs the report every hour.</td>
</tr>
<tr>
<td>Run Days</td>
<td>This option appears if you select the Weekly recurrence pattern. You can select the days of the week on which you want to run the job, by clearing the check boxes for the appropriate days.</td>
</tr>
</tbody>
</table>
### Run option

<table>
<thead>
<tr>
<th>Run option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
<td>Applies to most, but not all, recurrence patterns and Run options. The default is the current date and time. The system runs the job according to the specified schedule as soon as it can, after the Start Time has passed. For example, if you specify a start time that is three months from now, the system does not run the job until the start date has passed, even if all other criteria are met. However, once the start time has passed, the system runs the report at the specified time.</td>
</tr>
<tr>
<td>End Time</td>
<td>The default is the current time and a date in the distant future, to ensure that a job will run indefinitely. Specify a different End Time, if required. Once the End Time has passed, the lifecycle management console tool does not run the job.</td>
</tr>
<tr>
<td>Number of retries allowed</td>
<td>The number of times the system attempts to process a job if the first attempt fails. Applicable in all cases. By default, the number is zero.</td>
</tr>
<tr>
<td>Retry interval in seconds</td>
<td>The period, in seconds, that the system will wait before it attempts to process the job again, if the first attempt is unsuccessful. Applicable in all cases.</td>
</tr>
</tbody>
</table>

### 5.9.1 Scheduling a Job Promotion

This section describes how to schedule a job promotion. It also describes how to specify recurrence options and parameters.

To schedule a job promotion, complete the following steps:

1. In the "Promote - Job Name" window, click the **Schedule Job** option.
2. Select the appropriate schedule option from the Run Job drop-down list. Based on the Run Job option selected, the values displayed in the Objects will run field change automatically. For example, if you select the Weekly option, you must also specify the preferred days.

3. For the selected schedule, specify the parameters.
   You can also specify the number of retries allowed and the time interval between successive retries in the Number of retries allowed and Retry Interval in Seconds fields, respectively.

4. Click Save.

5.9.2 Updating the Recurring and Pending Job Promotion Instances

The lifecycle management console tool enables you to track and update the status of a scheduled job promotion instance by using the Recurring and Pending Instances option.

To track and update the scheduled job promotion instances, complete the following steps:

1. Log into the lifecycle management console tool.
2. In the "Promotion Job" home page, select a job.
3. Click History.
   The "Job History" window appears.
4. Click Recurring & Pending Instances.
The "Job History" window appears, as shown in the following figure:

![Job History Window](image)

This window displays the list of recurring and pending job promotion instances. Based on your requirements, you can use the following options:

- Click **Promoted Instances** to view the list of scheduled job promotion instances.
- Click the **Pause** option to pause the scheduled job promotion.
- Click the **Resume** option to resume the paused scheduled job promotion instance.
- Click the **Reschedule** option to reschedule a job promotion instance.
- Click the icon to delete a scheduled job promotion instance.
- Click the icon to refresh the status of a scheduled job promotion instance.
- You can use the option to navigate a single page, or navigate to a specific page by entering the relevant page number.

**Note:**
The status column in the "Job History for Recurring and Pending Instances" window displays the status of the job promotion instance, such as recurring, pending, and so on.

### 5.10 Viewing the History of a Job

The lifecycle management console tool enables you to view and track the status of a job promotion instance.

**Note:**
To view the history of a job, you must ensure that the status of the job is one of the following:
- Success
- Failure
- Partial Success
To view the history of a job, complete the following steps:

1. Log into the lifecycle management console tool.
   The "Promotion" home page appears.

2. Perform any of the following operations:
   • Right-click the job for which you want to view the history, and select **History**.
   • Select the job for which you want to view the history, and click the **History** tab.

The job instance, name of the job, names of the source and destination systems, the ID of the user who promoted the job, and the status (Success, Failure, or Partial Success) of the job are displayed.

You can view the status of the job by using the link displayed in the **Status** column. The status of the job is displayed, as shown in the following figure:

![Promotion Status: Promotion1](image)

### 5.10.1 Rolling Back a Job

The **Rollback** option enables you to restore the destination system to its previous state, after a job is promoted.

To roll back a job, complete the following steps:

1. Log into the lifecycle management console tool.
   The "Promotion" home page appears.

2. Perform any of the following operations:
   • Right-click the job that you want to rollback, and select **Rollback**.
   • Select the job that you want to rollback, and click the **Rollback** tab.

   The "Rollback" window appears.

3. Select the job you want to rollback, and click **Complete Rollback**.

The job is rolled back.

**Note:**
You can roll back only the most recent instance of a job promotion. You cannot roll back two job instances at the same time.
5.10.1.1 Using the Partial Rollback Option

The lifecycle management console tool enables you to roll back infoobjects that are included in a job. You can roll back either some objects in a job or all the infoobjects.

To roll back the infoobjects included in a job, complete the following steps:

1. Log into the lifecycle management console tool.
   The "Promotion" home page appears.
2. Perform any of the following operations:
   • Right-click the job you want to rollback, and select Rollback.
   • Select the job you want to rollback, and click the Rollback tab.
   The "Rollback" window appears.
3. Select the top-most job in the list, and click Partial Rollback.
   The list of infoobjects in the selected job is displayed in the "Job Viewer" page.
4. Select the infoobjects that you want to roll back, and click Rollback.

   **Note:**
   You must ensure that you have rolled back all the infoobjects in a job before you roll back the next job or infoobjects in the next job.

   **Important:** If a job is promoted with security, then, during the partial rollback of infoobjects, the security of the selected dependent infoobjects may not be rolled back to its previous state.

5.10.1.2 Rolling Back a Job After the Password Expires

This section describes how to roll back a job after the password for the source or destination system expires.

To roll back a job after the password expires, complete the following steps:

1. Select the job you want to roll back, and click Rollback.
   The "Rollback" page appears.
2. Select the required job instance, and click Complete Rollback.
   An error message is displayed. This message states that the job cannot be rolled back. You are also prompted to log into the source or destination system.
3. Enter the login credentials, and click Login.
   A dialog box appears indicating that the rollback process is complete.
The jobs that were promoted by using the source or destination system credentials are updated automatically.

**Related Topics**
- Using the Partial Rollback Option
- Rolling Back Infoobjects After the Password Expires

### 5.10.1.3 Rolling Back Infoobjects After the Password Expires

This section describes how to roll back infoobjects after the password for the source or destination system expires.

To roll back infoobjects after the password expires, complete the following steps:

1. Select the job you want to rollback, and click **Rollback**.
   The "Rollback" page appears.

2. Select the job you want to rollback, and click **Partial Rollback**.
   An error message is displayed. This message states that the infoobjects cannot be rolled back. You are also prompted to log into the source or destination system.

3. Enter the login credentials, and click **Login**.
   The "Job Viewer" page appears. This page displays the list of infoobjects.

4. Select the required infoobjects, and click **Rollback**.

   The jobs that were promoted by using this source or destination system credentials are updated automatically.
Managing Different Versions of an Infoobject

The lifecycle management console tool enables you to manage versions of BI resources that exist in the SAP BusinessObjects Business Intelligence platform repository. It supports both Subversion and ClearCase version management systems. This section describes how to use the Version Management feature in the lifecycle management console tool.

To create and manage different versions of an infoobject, complete the following steps:

1. Log into the lifecycle management console tool.
2. In the lifecycle management console home page, select Version Management from the drop-down list.
   The "Login to System" dialog box appears.
3. Enter the login credentials, and click Login.
   The "Version Management" window appears.
   **Note:** You can log into the version management system (VMS) only if it is already configured.
4. If you want to change the host system, click .
   The "Login to System" dialog box appears.
5. Enter the user credentials, and click Login.
6. From the left panel of the "Version Management" window, select the folder to view the infoobjects whose versions you want to manage.
7. Select the infoobjects and click Add to VM.
   **Note:** Clicking "Add to Version Management" results in the creation of a base version of the object in the VMS repository. A base version is required for subsequent check-in.
8. Click Checkin to update the document that exists in the VMS repository.
   The "Check-in Comments" dialog box appears.
9. Enter your comments, and click OK.
   The change in the version number of the selected infoobject is displayed in the VMS and Content Management System columns.
10. To obtain the latest version of the document from the VMS, select the required infoobject, and click Get latest Version.
11. To create a copy of the latest version, click Create Copy.
    A copy of the selected version is created.
12. Select History to view all the versions available for the selected resource.
The "History" window appears. The following options are displayed:

- **Get Version** - If there are multiple versions, and if you require a particular version of the BI resource, then you can select the required resource and click **Get Version**.
- **Get Copy of Version** - This option enables you to obtain a copy of the selected version.
- **Export Copy of Version** - This option enables you to obtain a copy of the selected version and save it to your local system.

13. Select an infoobject and click **Lock** to lock the infoobject and click **Unlock** to unlock the infoobject.

**Note:**
If you lock an infoobject, you cannot perform any action on that infoobject.

14. CMS and VMS Synchronisation - When the CMS version of the infoobject is updated, an indicator appears beside the updated infoobject. When you place the cursor on the indicator, you get a tool tip describing that the infoobject in the CMS is updated.

15. To view the list of all checked in resources that exist in the VMS, but not in the CMS, click **View Deleted resources**.

Click any deleted resource to view the history of that resource. You can select a deleted resource, and click **Get Version** to view that particular version of the resource. You can click **Get Copy of Version** to get a copy of the selected resource.

**Note:**
If you use either **Get Version** or **Get Copy of Version** option, the resource is moved to CMS from the VMS missing file list.

16. Select a resource, and click **⋯** to view the properties of the resource.

Alternatively, you can right click on the infoobject and perform Steps 4 to 16.

### 6.1 Backing Up and Restoring Subversion Files

This section describes suggested procedures to perform backups and recover subversion files. A backup and recovery plan consists of precautions to be taken in the event of a system failure due to a natural disaster or a catastrophic event.

#### 6.1.1 Backing Up Subversion Files

Complete the following steps to backup the subversion files:

1. Go to `<InstallDIR>\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise 4.0\CheckOut`
2. Copy the CheckOut folder and store in any backup device.
3. Copy the entire LCM_Repository and store in any backup device.
6.1.2 Restoring Subversion Files

Complete the following steps to restore subversion files:

1. Restore the CheckOut folder from the earlier backed up location.
   
   **Note:**
   In LCM > Administration options > VMS Settings > Subversion, ensure that the correct check out path is entered in the **Workspace Directory** field.

2. Restore the LCM_Repository from the earlier backed up location.
   
   **Note:**
   In LCM > Administration options > VMS Settings > Subversion, ensure that the correct check out path is entered in the **Install Path** field.
Using the Command Line Option

The Command Line option of the lifecycle management console tool enables you to promote objects through command line input from one SAP BusinessObjects Business Intelligence platform system to another SAP BusinessObjects Business Intelligence platform system.

The lifecycle management console tool supports the following job promotion through command line option:

- Export an existing LCM job template to LCMBIAR with password encryption.
- Export an existing LCM job template to LCMBIAR without password encryption.
- Promote with existing job template
- Import and promote an existing LCMBIAR
- Export single/multiple platform queries
- Promote multiple platform queries

7.1 Running the Command Line Option in Windows

To run the command line tool, complete the following steps:

1. Launch a command line window.
2. Navigate to the appropriate directory.
   For example, C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise 4.0\java\lib
3. Do one of the following:
   • Execute the LCMCLI, ensure the java path is set prior to running the program.
     Command: java -cp "lcm.jar" com.businessobjects.lcm.cli.LCMCLI <property file>
   • Run the BAT file from C:\Program Files (x86)\SAP Business Objects\SAP BusinessObjects Enterprise 4.0\win64_x64\scripts\lcm_cli.bat
     Command: lcm_cli.bat -lcmmproperty <property file>

Note:

The lifecycle management console command line tool takes a properties file as a parameter. The properties file contains the required parameters to communicate the lifecycle management console.
command line tool about the actions to perform, connection to which SAP BusinessObjects Business Intelligence platform deployment, connection methods, objects to promote, and so on.

The file must be in the form of <File Name>.properties

For Example: Myproperties.properties

7.1.1 Running the Command Line Option in UNIX

To run the command line tool, complete the following steps:

1. Launch shell.
2. Navigate to the appropriate directory.
   For example, /usr/u/qauinux/Aurora604/sap_bobj/enterprise_40/java/lib
3. Do one of the following:
   • Execute the LCMCLI, ensure the java path is set prior to running the program.
     Command: java -cp "lcm.jar" com.businessobjects.lcm.cli.LCMCLI <property file>
   • Run the BAT file from <installdir_path>\sap_bobj\lcm_cli.sh
     Command: lcm_cli.sh -lcmproperty <property file>

7.2 Command Line Option Parameters

The following table describes the parameters and the allowed values for the command line option of the lifecycle management console tool.
### Using the Command Line Option

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Allowed Values</th>
<th>Description</th>
<th>Mandatory vs Optional</th>
</tr>
</thead>
</table>
| action    | Export, Promote | This option enables you to specify the operation that the CLI must perform. This operation can perform any of the following operations:  
• Promote objects from an LCMBIAR file or an lifecycle management console Job to an SAP BusinessObjects Business Intelligence platform system.  
• Export objects from an SAP BusinessObjects Enterprise system to an LCMBIAR file. | Mandatory |
<p>| exportLocation | Free form text. Must have .lcmbiar extension | This parameter enables the user to specify the location to place the LCMBIAR file after the objects have been exported and packaged. | Mandatory if action=export |
| importLocation | Free form text. Must have .lcmbiar extension | This parameter enables the user to specify the location of the LCMBIAR file that contains the objects to be promoted. | Mandatory if action=import or action=export |
| LCM_CMS     | Free form text. | This parameter enables the user to specify the CMS for lifecycle management console. | Mandatory if action=import or action=export |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Allowed Values</th>
<th>Description</th>
<th>Mandatory vs Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCM_userName</td>
<td>Free form text. Example: LCM_userName=&lt;username&gt;</td>
<td>Enables the user to specify the account username that the tool must use to connect to the lifecycle management console CMS.</td>
<td>Mandatory if action=promote or export</td>
</tr>
<tr>
<td>LCM_password</td>
<td>Free form text. Example: LCM_password=&lt;password&gt;</td>
<td>Enables the user to specify the password of the user account.</td>
<td>Mandatory if action=promote or export</td>
</tr>
<tr>
<td>LCM_authentication</td>
<td>secEnterprise, secWinAD, secLDAP, secSAPR3 Example: LCM_authentication=&lt;authentication&gt;</td>
<td>Indicates the authentication type to be used.</td>
<td>Optional. If the authentication type is not specified, secEnterprise is used</td>
</tr>
<tr>
<td>LCM_systemID</td>
<td>System ID Example: LCM_systemID=&lt;systemID&gt;</td>
<td>This parameter is used for SAP authentication.</td>
<td>Mandatory for SAP authentication</td>
</tr>
<tr>
<td>LCM_clientID</td>
<td>Client ID Example: LCM_clientID=&lt;clientID&gt;</td>
<td>This parameter is used for SAP authentication.</td>
<td>Mandatory for SAP authentication</td>
</tr>
<tr>
<td>Parameter</td>
<td>Allowed Values</td>
<td>Description</td>
<td>Mandatory vs Optional</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Source_CMS</td>
<td>Free form text. Example: Source_CMS=&lt;CMS Sname: port no.&gt;</td>
<td>Enables the user to specify the CMS to which the lifecycle management console must connect.</td>
<td>Mandatory if action=export</td>
</tr>
<tr>
<td>Source_userName</td>
<td>Free form text. Example: Source_userName=&lt;username&gt;</td>
<td>Specifies the user account that the tool must use to connect to the BI platform CMS. <strong>Note:</strong> Delegated administrator is supported.</td>
<td>Mandatory if action=export</td>
</tr>
<tr>
<td>Source_password</td>
<td>Free form text. Example: Source_password=&lt;password&gt;</td>
<td>Specifies the associated password of the user account.</td>
<td>Mandatory if action=export</td>
</tr>
<tr>
<td>Source_authentication</td>
<td>secEnterprise, secWinAD, secLDAP, secSAPR3  Example: Source_authentication=&lt;authentication&gt;</td>
<td>Indicates the authentication type to be used.</td>
<td>Optional. If the authentication type is not specified, secEnterprise is used</td>
</tr>
<tr>
<td>Source_systemID</td>
<td>SAP System ID Example: Source_systemID=&lt;systemID&gt;</td>
<td>This parameter is used for SAP authentication only.</td>
<td>Mandatory for SAP authentication.</td>
</tr>
<tr>
<td>Source_clientID</td>
<td>SAP Client ID Example: Source_clientID=&lt;systemID&gt;</td>
<td>This parameter is used for SAP authentication only.</td>
<td>Mandatory for SAP authentication.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Allowed Values</td>
<td>Description</td>
<td>Mandatory vs Optional</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
</tbody>
</table>
| Destination_userName | Free form text. **Example:** Destination_userName=<username>                                                                                                                                                                                                                                                                                     | This parameter specifies the user account that the tool must use to connect to the BI platform CMS.  
**Note:** Delegated administrator is supported.                                                                                           | Mandatory if action=promote                                    |
| Destination_password | Free form text. **Example:** Destination_password=<password>                                                                                                                                                                                                                                                                                      | This parameter specifies the associated password of the user account.                                                                                                                                          | Mandatory if action=promote                                    |
| Destination_authentication | secEnterprise, secWinAD, secLDAP, secSAPR3  
**Example:** Destination_authentication=<authentication>                                                                                                                                                                                                                       | This parameter indicates the authentication type to be used.                                                                                                                                                    | Optional. If the authentication type is not specified, secEnterprise is used |
| Destination_systemID | System ID  
**Example:** Destination_systemID=<systemID>                                                                                                                                                                                                                                                                                           | This parameter is used for SAP authentication only.                                                                                                                                                    | Mandatory for SAP authentication.                              |
| Destination_clientID | Client ID  
**Example:** Destination_clientID=<systemID>                                                                                                                                                                                                                                                                                           | This parameter is used for SAP authentication only.                                                                                                                                                         | Mandatory for SAP authentication.                              |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Allowed Values</th>
<th>Description</th>
<th>Mandatory vs Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>includeSecurity</td>
<td>false, true</td>
<td>This parameter instructs the tool to export or import the security associated with selected objects and selected users. If access levels are used this will also export/import them.</td>
<td>Optional, if not specified the default is false. Used if action=promote or export</td>
</tr>
<tr>
<td>JOB_CUID</td>
<td>The CUID of the saved LCM job.</td>
<td>This parameter instructs the tool to export all the objects in the job to the LCM-BIAR file.</td>
<td>Optional, used if action=export or promote</td>
</tr>
<tr>
<td>exportQuery</td>
<td>Free form text. Use the CMS query language format. Example: export Query1=select*from ci_Infoobjects where si_name='Xtreme Employees' and si_kind='Webi'</td>
<td>These are the queries the tool should execute to gather the desired objects for exportation.</td>
<td>Optional, used if action=export</td>
</tr>
</tbody>
</table>

**Note:**
You can have any number of queries in one properties file, but they must be named as exportQuery1, exportQuery2, and so on.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Allowed Values</th>
<th>Description</th>
<th>Mandatory vs Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>exportQueriesTotal</td>
<td>Positive whole numbers&lt;whole number&gt;</td>
<td>This parameter enables the user to specify the number of export queries to execute. If you have x export queries and want to execute them all, you must set this parameter value to x.</td>
<td>Optional, used if action=export. If not specified, default equals 1</td>
</tr>
<tr>
<td>stacktrace</td>
<td>true or false</td>
<td>This parameter enables the user to trace all calls.</td>
<td>Optional, if not specified, default equals false</td>
</tr>
<tr>
<td>lcmiarpassword</td>
<td>Free form text</td>
<td>This parameter enables the encryption and decryption of BIAR files using a password.</td>
<td>Optional, if not specified or if the string is empty, implies there is no encryption</td>
</tr>
<tr>
<td>lcmproperty</td>
<td>The full path of the location where property file has been saved</td>
<td>This parameter refers to the values required for the execution of a command, which are saved in a file.</td>
<td>Mandatory</td>
</tr>
<tr>
<td>consolelog</td>
<td>true or false</td>
<td>This parameter is used to display the complete log of the command executed by the user in the command log.</td>
<td>Optional</td>
</tr>
</tbody>
</table>
**Note:**

- Similar to creation of a job before exporting, the Command Line option creates a temporary job on the fly. This job name could be a combination of `Query_<USER>_<Timestamp>`. This is specific only to `exportQuery`.
- The exported LCMBIAR file naming convention can be a combination of `<JobName>_<Timestamp>.lcmbiar` for uniqueness when lcmbiar name is not specified in the `exportLocation` file.
- You can rollback the job only through the lifecycle management console tool. There is no command line support to rollback the jobs.

### 7.3 Sample Properties File

Following is the example of sample properties file:

Example:

```plaintext
importLocation=C:/Backup/CR.lcmbiar
action=promote
LCM_CMS=<CMS name:port number>
LCM_userName=<username>
LCM_password=<password>
LCM_authentication=<authentication>
LCM_systemID=<ID>
LCM_clientID=<client ID>
Destination_CMS=<CMS name:port number>
Destination_userName=<username>
Destination_password=<password>
Destination_authentication=<authentication>
Destination_systemID=<ID>
Destination_clientID=<client ID>
lcmbiarpassword=<password>
```
Using the Enhanced Change and Transport System

The Change and Transport System (CTS) organizes and customizes development projects in the ABAP Workbench, and then transports these changes between SAP Systems in your system landscape. The Enhanced Change and Transport System (CTS+) is an add-on to the CTS that promotes non ABAP content across CTS+ enabled non-ABAP repositories.

SAP BusinessObjects Business Intelligence platform (BI platform) infoobjects can use SAP Business Warehouse content as a data source. The integration of CTS+ with Lifecycle management console (LCM) enables the handling of the SAP BusinessObjects Business Intelligence platform repository, in a similar way to the SAP Business Warehouse (BW) repository, by using CTS transport requests to promote LCM jobs. CTS+ provides an option to transport non-SAP objects within a system landscape. For example, objects created in the development system can be attached to a transport request and forwarded to other systems within the landscape.

For more information about the Change and Transport System, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/3b/dfba3692dc635ce10000009b38f839/frameset.htm

For more information about CTS+ and non ABAP transports, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/bb/6fab6036a146baa58e42fac032ab7b/frameset.htm

8.1 Pre-requisites

1. **SAP BusinessObjects Business Intelligence platform 4.0** (BI platform) is installed.
2. **SAP NetWeaver Composition Environment 7.2** (SPS 03 or higher) is installed and it has BusinessObjects LCM Web Application or the complete **SAP BusinessObjects Business Intelligence platform 4.0** is deployed on it.
3. **SAP Solution Manager 7.0 EHP1 SP25** is installed and is used as the domain controller for CTS+, at least for the configuration of SAP BusinessObjects systems.

   For more information about configuring the transport domain, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a0a77acc11d1899e0000e829fbbd/frame set.htm

4. **SAP Business Warehouse 7.0** (SPS 24 or higher) systems are installed. For more information, see SAP note https://service.sap.com/sap/support/notes/1369301
5. SAP Business Warehouse (SAP BW) transport landscape is configured in the Change and Transport System.
8.2 Configuring the Integration

The Transport Management System (TMS) which is part of the Change and Transport System is used to transport changes between the SAP systems within a landscape. It manages the connected systems, their routes, and the imports into its systems. For more information about the Transport Management System, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a0137acc11d1899e0000e829fbbd/frameset.htm

CTS+ enables collection of files from outside and their distribution within a transport landscape. The Transport Organizer Web UI, which is part of CTS+, manages the transport requests and the objects contained by it. For more information, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a0137acc11d1899e0000e829fbbd/frameset.htm

You can integrate SAP BusinessObjects Business Intelligence platform LCM with CTS+ and SAP BW using CTS transport requests.

8.2.1 Setting Up CTS for BusinessObjects-Lifecycle Management Console Usage

The following section describes the configuration steps to be performed in each system to set up CTS for BusinessObjects - Lifecycle management console usage.

1. In the BI platform development system, you need to create two text files with details related to connectivity to map the following:
   - The source SAP BusinessObjects Business Intelligence platform CMS to one or more RFC destinations pointing to source SAP NW BW AS ABAP stacks to enable the dependency check between SAP BusinessObjects Business Intelligence platform and SAP BW development systems.
   - The source SAP BusinessObjects Business Intelligence platform CMS to the logical name of the system in the Solution Manager CTS to retrieve the correct names for new transport requests.
For more information about the mapping parameters used here, see the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;BW System ID&gt;</td>
<td>This parameter refers to the system ID (SID) of the SAP BW/ABAP machine that contains the SAP BW objects used by connections in the source SAP BusinessObjects Business Intelligence platform system. This is the source SAP BW machine from which SAP BW objects are transported to the destination SAP BW machine.</td>
</tr>
<tr>
<td>&lt;RFC destination name&gt;</td>
<td>This parameter refers to the RFC destination that is configured to connect to SAP BW/ABAP system mentioned above. You set this RFC destination on the SAP NetWeaver machine on which LCM is deployed.</td>
</tr>
<tr>
<td>&lt;BI platform source system name&gt;@&lt;CMS port number&gt;</td>
<td>This parameter refers to the system name and port name of the source SAP BusinessObjects Business Intelligence platform system, chosen on the LCM UI during job creation.</td>
</tr>
<tr>
<td>&lt;logical name for source system as used in CTS configuration&gt;</td>
<td>This parameter refers to the SAP NetWeaver source system that is logically mapped to the source SAP BusinessObjects Business Intelligence platform system mentioned above. The objects from the source SAP BusinessObjects Business Intelligence platform system are attached to the transport requests hosted on the transport system using this SID. This could be different from the SAP NetWeaver system on which LCM is deployed. This parameter name can be freely defined, but typically 3 letter acronyms are used.</td>
</tr>
</tbody>
</table>

Complete the following steps to map the files:

a. In the SAP BusinessObjects Business Intelligence platform LCM CMS, go to the root directory and create a folder with name LCM in the path <SAP BusinessObjects Business Intelligence platform install path>/SAP BusinessObjects Business Intelligence platform 4.0 /

b. In this folder, create a text file with the name LCM_SID_RFC_MAPPING.properties and make the following entry: <BW System ID> = <RFC destination name>. For example: BWD=BWD.RFC, where the SID of the BW development system is BWD.

c. Create another text file with name LCM_SOURCE_CMS_SID_MAPPING.properties, and enter either one of the following in the file:
   - <Complete name of the SAP BusinessObjects Business Intelligence platform source system with domain>@<CMS port number> = <logical name for source system as used in CTS configuration >
   - <IP number of the SAP BusinessObjects Business Intelligence platform source system>@<CMS port number> = <logical name for source system as used in CTS configuration >
2. In the SAP BusinessObjects Business Intelligence platform test system and SAP BusinessObjects Business Intelligence platform production systems, do the following
   a. Create user accounts and assign authorizations.

   **Note:**
   It is preferable to maintain identical user ID's across the landscape.

   For more information, see Configuring SAP authentication and Creating a user account for SAP BusinessObjects Enterprise in the SAP BusinessObjects Enterprise Administrator's Guide

3. In SAP NetWeaver Composition Environment 7.2, do the following:
   a. Deploy the Web Applications for SAP BusinessObjects Business Intelligence platform 4.0 on SAP NetWeaver. For more information, see the SAP BusinessObjects Enterprise 4.0 Web Application Deployment Guide.
   b. Configure the RFC destination to CTS ABAP server.
      1. Logon to SAP NetWeaver Administrator using the following URL: http://<hostname>:<port>/nwa. For more information, see http://help.sap.com/saphelp_nwce72/helpdata/en/49/49b19720cc3b5be10000000a42189b/frameset.htm
      2. Create an RFC destination sap.com/com.sap.tc.di.CTSserver under Configuration > Infrastructure > Destinations

   For more information about creating RFC destinations, see http://help.sap.com/saphelp_nwce72/helpdata/en/5a/97a066223e440b8ead3da027b17d9e/frame set.htm

   The user should be assigned the SAP standard profile authorization, SAP_CTS+ authorization and some additional authorizations. For more information about the additional authorizations see the Known Errors section for the relevant SAP NetWeaver version used in your Solution Manager system, in SAP Note https://service.sap.com/sap/support/notes/1003674.
   c. Configure the RFC destination to all SAP BW development systems by completing the following steps:
      1. Logon to SAP NetWeaver Administrator using the following URL: http://<hostname>:<port>/nwa. For more information, see http://help.sap.com/saphelp_nwce72/helpdata/en/49/49b19720cc3b5be10000000a42189b/frameset.htm
      2. Choose Configuration > Destination. The "Destinations" screen appears. For more information about destinations, see http://help.sap.com/saphelp_nwce72/helpdata/en/c4/4bf969fb2a48908224679e83e9d805/frameset.htm
      3. Click Create.
      4. Enter the appropriate details in the Hosting System, Destination Name and Destination Type fields.

         **Note:**
         The details to be entered here are the credentials for the SAP BW SID (the source ABAP system), which contains the SAP BW objects used by the source SAP BusinessObjects Business Intelligence platform connections.
      5. Click Next and complete the process.

4. In Solution Manager CTS ABAP, perform the following steps
   a. Activate CTS+ functionality by completing the following steps:
1. Log on to the Solution Manager system with a user that has CTS administration permissions.
2. Go to transaction SE38.
3. Choose **Program > Execute > Direct processing** to execute report RSTMS007. Alternatively you can also press **F8**.
   The TMS report screen appears.
4. Enter the value "CTSBOLM42 in the key field and execute.
   On successful execution, the entry exists now message appears.

b. Enable the CTS+ domain for the SAP BusinessObjects LCM application(BOLM) by completing the following steps:
   1. Log on to the CTS+ domain controller.
   2. Call the STMS transaction.
   3. Click **Overview > Systems**
      The "System Overview" screen appears
   4. Click **Extras > Application Types > Configure** to configure the domain for enabled application types.
   5. Click **Edit > New Entries**
      The "New Entries" screen appears .
   6. In the **Application Type**, **Description** and **Support Details** fields, enter BOLM, BO LCM and CTS+ integration and http://service.sap.com (ACH: BOJ-BIP-DEP) respectively.
   7. Click **Table View > Save**
      The confirmation popup appears.
   8. Click **Yes**.
   9. To work with different languages, you can maintain translated texts as follows:
      a. Choose **Goto > Translation**.
      b. Select the languages that you want to translate the text into.
      c. Enter the translated values in the **Description** and **Support Details** fields.
      d. Confirm the dialog box.
      e. Click **Continue**.
      f. Choose **Table View > Save**.
      g. Confirm the prompt.
      The TMS domain is now ready to support usage of BO LCM content in CTS.

c. In CTS+, define the SAP BusinessObjects Business Intelligence platform source system as an export system.
   **Note:**
   Use the logical name for source system defined in the LCM property file LCM_SOURCE_CMS_SID_MAPPING.
   For more information about creating a non-ABAP system as a source system, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/bf/e4626214504be18b2f1abeef4f8e4/frame set.htm
d. In CTS+, configure the SAP BusinessObjects Business Intelligence platform import system by completing the following steps:

**Note:**
You can freely define a SID as reference to the SAP BusinessObjects Business Intelligence platform import system.

1. Create a Non-ABAP system as a import system. For more information, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/bf/e4626214504be18b2ff1abeeaaf4f8e4/frameset.htm
2. Specify the deployment method as **Others**, deselect all the other options.
3. Click **Save**.
4. Confirm the distribution dialog box.
   The table view to configure the import system settings appears.
5. Choose **Edit > New Entries**.
6. On the "New Entries" screen enter the following:
   - **Application Type:** BOLM
   - **Deploy URL:** http://<SAP BusinessObjects Business Intelligence platform web server name>:<Web server port>/BOE/LCM/CTSServlet?&cmsName=<SAP BusinessObjects Business Intelligence platform destination name>:<CMS port>&authType=<SAP BusinessObjects Business Intelligence platform authentication type>

   For example: Deploy URL:http://10.66.149.22:8080/BOE/LCM/CTSServlet?&cmsName=10.66.149.22:6400&authType=secSAPR3

   **Note:**
   The deploy URL contains the LCM CMS name and the destination SAP BusinessObjects Business Intelligence platform CMS name.

7. Enter the destination CMS user name, password and use SAP authentication.
   The username is in the following format : System ID~Client ID\username. For example, WA1~001\OTOADMIN

   **Note:**
   All jobs promoted to the destination system using CTS+ uses this username and password by default.

8. Save the settings.

e. If you require more than one target system, repeat the steps above to create all destination systems required.

f. To configure transport routes between the source and target system after the creation of the destination systems, see http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a1df7acc11d1899e0000e829fbbd/frameset.htm

5. In the SAP BW development system, complete the following steps:
a. Go to **Tools > Administration > User Maintenance > User** and create users with the same user ID's used in the SAP BusinessObjects Business Intelligence platform LCM tool.

b. Assign RFC AUTH and BW AUTH authorizations to these users to check dependencies from the SAP BusinessObjects Business Intelligence platform development system.

6. In SAP BW test system and SAP BW production systems, complete the following steps:
   a. Create users with the same IDs.
   
   **Note:**
   In this case, no special authorizations are required for CTS+ integration.

   For more information about performing configuration steps for non-ABAP systems, see [http://help.sap.com/saphelp_nw70/helpdata/en/d4/3bab83106941f08ad1f2e1ec14375e/frameset.htm](http://help.sap.com/saphelp_nw70/helpdata/en/d4/3bab83106941f08ad1f2e1ec14375e/frameset.htm)

### 8.3 Promoting a Job Using CTS

This section describes the workflow that the lifecycle management console tool supports for promoting SAP BusinessObjects Business Intelligence platform Central Management Server (CMS) objects from the source system to destination system using the Change Transport System. To use CTS to promote a job, complete the following steps:

1. Log on to the Lifecycle management console tool using SAP authentication, and create a job.
   
   For more information on creating a new job, see [Creating a New Job](#).

2. From the **Destination** drop-down list, select **promote via CTS** option.

   The "Add Objects from the System" screen appears. Here the folders and subfolders are displayed in a tree structure.

3. Click **Create**.
   
   The "Add Objects from the System" screen appears. Here the folders and subfolders are displayed in a tree structure.

4. Navigate to the folder from which you want to select the infoobject.

5. Select the infoobject that you want to add to the job, and click **Add**. If you want to add an infoobject and exit the "Add Objects" screen, click **Add and Close**.
   
   The infoobject is appended to the job and the "Promotion Jobs" screen appears.

   **Note:**
   On the Promotion Jobs screen you can do the following:
• Use the **Add Objects** option to add more info objects to the job. For more information, see **Adding an Infoobject to a job**.

• Use the **Manage Dependencies** option to manage the dependencies of the info object you have selected. The SAP BW dependencies of the object are displayed on the UI and available for the user to select.

  For more information, see **Managing Job Dependencies**.

6. **Click Promote**.

   The "Promote" screen appears which displays the ID, owner and a short description of the currently set default transport request.

7. You can use the **Transport Requests** hyperlink to do the following:

   • View details of the transport request.
   • Change settings of the default transport request.
   • Choose a different transport request.
   • Create a transport request.

   a. Click the **Transport Requests** hyperlink to open the "Transport Organizer" Web User Interface.
   b. If prompted for logon credentials, log on using valid user credentials for the CTS domain controller system.
   c. Refresh the "Promote" Screen to view your updates.


8. To view the details of the dependencies of the SAP BW objects, click the **Second level dependencies** hyperlink.

   **Note:**
   
   Only the objects that are locked in a request are displayed when you click the **Second level dependencies** hyperlink. If the request has been released you can not view any dependencies. In addition, this hyperlink is grayed out if there are no active second level dependencies.

9. **Click Promote**.
10. Close the job.

    The LCM main screen is displayed. The status of the job that you created is now **Exported to CTS**.

11. Release the SAP BusinessObjects Business Intelligence platform object to the destination system by completing the following steps:

    a. Click the link displayed in the status column of the job that you want to promote.

        The "Promotion Status" window appears.

    b. Click **State of Request**.

        The "Transport Organizer" Web UI appears.

    c. If the status of the request is **Modifiable**, click **Release** to release the transport request of the SAP BusinessObject Business Intelligence Platform object. For more information about releasing transport requests containing non-ABAP objects, see [http://help.sap.com/saphelp_nw70ehp1/helpdata/en/55/07c497db8140ef8176715d4728eec1/frame set.htm](http://help.sap.com/saphelp_nw70ehp1/helpdata/en/55/07c497db8140ef8176715d4728eec1/frame set.htm)
d. Close the "Transport Organizer" Web UI.

12. To view the dependencies for the SAP BW objects, click **List of BW dependencies** hyperlink.

**Note:**
We recommend talking to the SAP BW team to get updates on the SAP BW dependencies and their release as these objects are worked on by the team.

13. Close the "Promotion Status" window.

14. Import the SAP BusinessObjects Business Intelligence platform object to the destination system by completing the following steps:
   a. Log on to the CTS+ domain controller.
   b. Call the STMS transaction to enter the transport management system.
   c. Click on the **Import Overview** icon.
      The "Import Overview" screen appears and you can view the import queue items from all the systems.
   d. Choose the system ID of the destination LCM system.
      You can see the list of transport requests that can be imported to the system.
   e. Click **Refresh**.
   f. Import the relevant transport requests. For more information, see [http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a39e7acc11d1899e0000e829fbdb/frame set.htm](http://help.sap.com/saphelp_nw70ehp1/helpdata/en/44/b4a39e7acc11d1899e0000e829fbdb/frame set.htm)
      For general information about importing transport requests with BOLM content, see [http://help.sap.com/saphelp_nw70ehp1/helpdata/en/09/ca0f3a878bf6e9a5a32e66131d2ba/frame set.htm](http://help.sap.com/saphelp_nw70ehp1/helpdata/en/09/ca0f3a878bf6e9a5a32e66131d2ba/frame set.htm)

15. If the object that you selected has SAP BW dependencies, perform the following steps:
   a. Release the SAP BW dependencies to the destination system by completing the following steps:
      1. Log on to the SAP BW source system.
      2. Call SE09 transaction. The "Transport Organizer" screen appears.
      3. Click **Display**. The SAP BW request is displayed.
      4. Click the SAP BW request and expand it to view the tasks created for the dependencies.
      5. Right click the request associated with the primary SAP BW object and select **Release Directly**. Repeat this step to release all the tasks associated to each dependent separately.
      6. Right click on the request associated to the primary BW object and select **Release Directly**.
      7. Refresh the screen until all the requests are released.
         **Note:**
         You can view the logs for a request by double clicking it.
   b. Import the SAP BW dependencies to the destination system by completing the following steps:
      1. Log on to the SAP BW destination system.
      2. Call the STMS transaction to enter the transport management system.
      3. Click the **Import Overview** icon. The "Import Overview" screen appears.
      4. Double-click the system ID for the SAP BW destination. You can see the list of transport requests that can be imported to the system.
5. Import the relevant transport requests. For more information, see http://help.sap.com/saphelp_nw70ehp1/helpdata/ta/en/44/b4a39e7acc11d1899e0000e829fbbd/frameset.htm

For more information about Transports with Import Queues, see http://help.sap.com/saphelp_nw70ehp1/helpdata/ta/en/65/8a99386185c064e10000009b38f8cf/frameset.htm

16. Log on to the destination LCM system to view the status of the job you promoted.

Related Topics

• Creating a New Job
• Managing Job Dependencies
# More Information

<table>
<thead>
<tr>
<th>Information Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Help Portal</td>
<td>Navigate to <a href="http://help.sap.com/businessobjects">http://help.sap.com/businessobjects</a> and on the “SAP BusinessObjects Overview” side panel click <strong>All Products</strong>. You can access the most up-to-date documentation covering all SAP BusinessObjects products and their deployment at the SAP Help Portal. You can download PDF versions or installable HTML libraries. Certain guides are stored on the SAP Service Marketplace and are not available from the SAP Help Portal. These guides are listed on the Help Portal accompanied by a link to the SAP Service Marketplace. Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact your customer support representative.</td>
</tr>
</tbody>
</table>
| SAP Service Marketplace | [http://service.sap.com/bosap-support > Documentation](http://service.sap.com/bosap-support > Documentation)  
- Installation guides: [https://service.sap.com/bosap-instguides](https://service.sap.com/bosap-instguides)  
- Release notes: [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes)  
The SAP Service Marketplace stores certain installation guides, upgrade and migration guides, deployment guides, release notes and Supported Platforms documents. Customers with a maintenance agreement have an authorized user ID to access this site. Contact your customer support representative to obtain an ID. If you are redirected to the SAP Service Marketplace from the SAP Help Portal, use the menu in the navigation pane on the left to locate the category containing the documentation you want to access. |
| Docupedia | [https://cw.sdn.sap.com/cw/community/docupedia](https://cw.sdn.sap.com/cw/community/docupedia)  
Docupedia provides additional documentation resources, a collaborative authoring environment, and an interactive feedback channel. |
| Developer resources | [https://boc.sdn.sap.com/](https://boc.sdn.sap.com/)  
<table>
<thead>
<tr>
<th>Information Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>These articles were formerly known as technical papers.</td>
</tr>
<tr>
<td>Notes</td>
<td><a href="https://service.sap.com/notes">https://service.sap.com/notes</a></td>
</tr>
<tr>
<td></td>
<td>These notes were formerly known as Knowledge Base articles.</td>
</tr>
<tr>
<td></td>
<td>From traditional classroom learning to targeted e-learning seminars, we can offer a training package to suit your learning needs and preferred learning style.</td>
</tr>
<tr>
<td>Online customer support</td>
<td><a href="http://service.sap.com/bosap-support">http://service.sap.com/bosap-support</a></td>
</tr>
<tr>
<td></td>
<td>The SAP Support Portal contains information about Customer Support programs and services. It also has links to a wide range of technical information and downloads. Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact your customer support representative.</td>
</tr>
<tr>
<td></td>
<td>Consultants can accompany you from the initial analysis stage to the delivery of your deployment project. Expertise is available in topics such as relational and multidimensional databases, connectivity, database design tools, and customized embedding technology.</td>
</tr>
</tbody>
</table>
Index

A
Add
  infoobjects 29
Administration options 7
Administrator and Details panel 11
Auditing 7
authentication
  Enterprise 13
  LDAP 13
  SAP 13
  Windows AD 13
Authentication 25
B
  base version 45
Behavior
    Application Rights 8
  BIAR file 35
business intelligence 5
  Business Intelligence Platform 33
  Business Views 33
C
  CMS 7
  complete rollback 43
Copy
  existing job 28
Create new job
  copying an existing job 28
D
Delete instances 7
Delete Object 7
dependencies 5
dependent objects 30
dependents
  locate 30
  search 30
development 5
E
edit
  job 29
Edit Objects 7
Enterprise authentication 13
exporting a job 35
  External Change Management ID 33
F
filtering 30
H
history
  job 41
  History 11
I
import
  job 36
import job
  BIAR file 36
infoobject
  different versions 45
infoobjects
  addition 29
  promotion 35
instances
  pending 40
  recurring 40
J
job
  edit 29
  export 35
  rollback 42
job session 7
  Job Settings 14, 20
L
  LDAP authentication 13
lifecycle management console 5
  features 5
  job rollback 42
  promoting jobs 33
  repositories 33
  workflows 33
lifecycle management console tool
  recurrence patterns 37
lifecycle management repository 28
life management tool
  Promotion Job 25
locate
  dependents 30
M
Manage Dependencies 29
Manage Systems 14
  Host name
    Display name 14
    Port number 14
Managing Dependencies 7
Mapping
  Connection Mappings
    Crystal report Mappings 7
    Federation Mappings 7
    QaaWS Mappings 7
  Scheduling 7
N
new job creation
  GUI elements 25
O
objects in Job 30
Override Settings 14
P
partial rollback 43
Preferences 11, 23
primary resources 30
product life cycle 5
production 5
Promote Security 33
Promotion 7
  promotion task 29
  Promotion with security 8
  Promotion without security 8
R
recurrence patterns
  lifecycle management console tool 37
Reports 33
Index

roll back
  infoobjects 43
  job 42
rollback
  infoobjects 44
  job 43
  process 43
rollback selection 43
Rollback Settings 14, 19
Run options 37

S
SAP BusinessObjects Enterprise system 30
schedule
  job promotion 37, 39
Schedule Job 7
Schedule settings 33
search
  dependents 30
Search 11
Search All Fields 28
Search Description 28
Search Keyword 28
Search Title 28
Security 7
Shopping Cart and Job Viewer page 11
Subversion 45
Subversion Settings 20

T
Test Promotion 7, 33
testing 5
Third-Party Objects 33
Tree panel 11

U
Universe 30
Universe restriction set 30
update
  promotion instances 40
User rights 7

V
version control system 45
View Rights 33
 viewing
  job history 41
VMS repository 45
VMS Settings 14

W
Windows AD authentication 13
Workspace panel 11